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2.1 Start-up of Server Management Functions 
You can manage the operating status of all the number of distributed server on the screen of NEC ESMPRO 
Manager. 
In Operation Window and DataViewer, efficient server management can be done by stratified management 
items. 
In AlertViewer, all the report (Alert) of managed server can be managed. 
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1. How to activate NEC ESMPRO Manager 

1.  Select [Program] from [Start] menu of taskbar, and [NEC ESMPRO Manager] from program group. 

 
Start-up of NEC ESMPRO Manager 

2.  Operation Window and AlertViewer activate. In normal operation, check whether or not failure 
happens by Operation Window and AlertViewer. Activate DataViewer when you would like to know 
configuration information of server and each monitoring information, if necessary. 

 
AlertViewer is minimized after its activation. Select from taskbar when you use. 
 

 
 

Operation to activate NEC ESMPRO Agent is not necessary. After activation of machine, it automatically 
starts to monitor the operating status. 
 
NEC ESMPRO Manager manages based on IP address. Therefore, do not use DHCP that IP address 
changes dynamically. 
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2.2 Easy Registration of Server to be Managed 
(Operation Window) 

By using automatic discovery function of Operation Window, you can discover the managed server from 
network and register it on Operation Window. 
Furthermore, by setting the automatic discover regularly, you can automatically register it on Operation 
Window when server is added. 
 

 
 

2.2-1 How to discover server automatically 

1. Procedures 

1.  Activate Operation Window, select map with mouse to register the server to be discovered 
automatically. 

2.  Select [Autodiscover] from [Tools] menu and select [TCP/IP Hosts…] from [Foreground]. 
3.  Input the SNMP community name set on the server to be discoverd into the [SNMP Community]. 
4.  Press [Start] button. 
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[AutoDiscover] Dialog Box 

AutoDiscover function also discovers and registers hosts on which NEC ESMPRO Agent is not installed.  
 
 
Narrowing AutoDiscover Target 
It may require considerable time in case that the object of AutoDiscover is all the addresses in sub 
network designated in specified value. In case that IP address is preliminarily known, by pressing 
[Address…] button and refining the object, you can discover the server for monitoring object in a short 
time. 
 
To discover network via router automatically, you must preliminarily register map icon of network 
manually. When you execute AutoDiscover to map icon of the network, server is registered under the 
map icon. 

 
About Managed Servers 
There is no limitation that an NEC ESMPRO Manager can manage multiple servers but performance 
deteriorates as the multiple servers to be managed increases. Therefore, in operation, the limit number 
of server to be managed should be around 250 and system should be built considering this point. 

 
 

2. How to execute AutoDiscover regularly 

1.  Select map of network you turn into an object of regular AutoDiscover by left tree of Operation 
Window. 

 
At this time, select [Properties] with right mouse button and check that [Network Address] and 
[Network Mask] are set. In case map icon is not set, regular AutoDiscover can not be set. 
 

2.  Select [Autodiscover]-[Background…] from [Tools] Menu. 
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[Background AutoDiscover] Dialog Box 

3.  Check [Enable AutoDiscovery], set the details, pressing [Details…] button, if necessary. 
4.  Close settings screen, pressing [OK] button. 
 

When you set AutoDiscover regularly, server icon is automatically registered in Operation Window when 
a new server is added. However, when the number of server decreases such as dismantlement, as the 
server icon remains unchanged, you need to manually delete it. 

  
When you set AutoDiscover regularly, server icon is automatically and conveniently registered in 
Operation Window when a new server is added. However, packet to network increases. 
It is recommended not to use this function in case of environment where add-on of server is not taken 
into account. or for the network where billing problem such as WAN may happen. 
Please note that you must be very careful of setting interval when you use it. 

 

3. How to change map configuration 

The layer system of registered server can be changed. 
 
1.  Select location to make a new map in Operation Window Tree. 
2.  Select [Icon Palette] of [View] menu and open Icon Palette. 

 
[Icon Palette] Dialog Box 

3.  After selecting map icon to make in Icon Palette, when you click right pane of Operation Window, 
new map icon is attached. 

4.  Then, as dialog box to set attribute of map icon is displayed, set necessary items. 
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[Properties] Dialog Box 

5.  Select server icon you want to move, and move the server icon under a new map icon by cut & 
paste. 

 

[New Map] 
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2.2-2 How to monitor server status 

For AutoDiscovered server on 2.2-1, its status is periodically monitored and the color of server icon of 
Operation Window changes, depending on its situation. 

 

The color of server icon of Operation Window is set by default as follows:  
 

Server Status Color of Server Icon 
Normal Green 
Warning Yellow 

Error Red 
Unknown Gray 

 
 

About Status Color of Server Icon 
You can change the status color of server icon for server status. 
1.  Select [Options] from Operation Window menu. 
2.  Select [Customize] - [Fault Indicators…] from displayed menu. 
3.  Click the status you want to change from [Fault Indicators], and press [Change…]   

button. 
4.  Select the color you want to set and press [OK] button, and close [Fault Indicators]  

Dialog box. 
 
In case the monitoring target server stops or is in sleep mode and some problem on network happens, 
the status color of server icon is gray (unknown). 
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1. How to check setting of status monitoring of server 

1.  Right-click server icon you want to check on Operation Window. 
2.  Select [Properties] from menu. 
3.  Select [WatchState] tab. And check the value of [Watch Server Status] is ”On”. When the value of 

[Watch Server Status] is ”On”, server is monitored, while it is ”Off”, it is not. 
 

Between NEC ESMPRO Manager and NEC ESMPRO Agent, packet is sent and received at the following 
time.: 
Please be very careful of system operation in which billing problem such as WAN may happen. 
 
- When regular polling such as around every 1 minute to monitor server status if you set "Watch 

Server Status" Off on property of server icon, you can avoid it. However, the icon color of Operation 
Window does not reflect the server status. 

- When you execute AutoDiscover of server by Operation Window 
- When you execute AutoDisover at designated intervals after setting steady AutoDiscover by 

Operation Window 
- When you execute Remote Wake Up by Operation Window 
- When you execute Remote Shutdown by Operation Window 
- Irregularly after setting Inter-Manager Communication  
- When you receive SNMP trap 
- When you collect information around every 1 minute after start-up of DataViewer  
- When you collect information around every 1 minute after start-up of GraphViewer 
- When you collect information at a designated interval after setting automatic statistical information 

collection 
 

Normal color is set for the status color of server icon when server status monitor is not executed. 
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2.2-3 How to detect shut down and recovery of server 

By utilizing Server Down Detection function, you can monitor shut down and recovery of server. 
In case of shut down of server, alert of “No response from the server.” is reported to AlertViewer. 
In case of recovery by reboot etc., alert of “The server access recovered.” is reported to AlertViewer. 
 

 
 
 

1. Preparation 

1.  Right-click server icon relevant on Operation Window and select [WatchState Settings]. 
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[WatchState Settings] Dialog Box of Server 

2.  Confirm that the checkbox of [Watch Server Status] is checked. In case [Watch Server Status] 
item is not checked, check the checkbox of [Watch Server Status]. 

 
In case the checkbox of Watch Server Status is not checked, alert of shut down and recovery of server 
is not reported. 

 
3.  Check the checkbox of [Send] of [Detect Server Down]. 
4.  Input number of retry until detecting server down in [Server Down Detection Retry Count]. 
 

Set the number of retry until detecting server down by status monitoring. 
Setting the number of retry properly can avoid alert reported when the status where communication 
can not be done by temporary network failure, high-load of server and etc. is deemed as server down. 
 

5.  In case of monitoring server down constantly select “(Send Always)” by [Schedule Form Name] 
and press the [Set] button. 

 
When you shut down server regularly for operation, you can suppress alert reported in case of server 
down, by setting schedule in advance. 
To Set Schedule 
 

1.  Press  button of [WatchState Settings] screen and display [Create Form]  
Dialog Box 

2.  Input name of schedule form and press [OK] Button. 

 

[Create Form] Dialog Box 
 

3.  Press [Add] button of [WatchState Settings] screen, set the schedule and press [OK] button. 
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[Schedule Settings] Dialog 

4.  Press  button of [WatchState Settings] Dialog. The contents indicated on schedule list are 
reflected in selected schedule form. 

5.  Select schedule form to use and press [Set] button. 
6.  Press [Close] button and close [WatchState Settings] Dialog. 

 

The mark “*” beside the name of schedule form means under editing. If you close [WatchState 

Settings] Dialog without pressing  button, the contents you are editing are not saved. 

 
When you shut down server regularly, you can control alert reported in case of server down, by setting 
schedule in advance. 

 
By [WatchState] tab of server property on Operation Window, you can set alert reporting function in 
case of server failure but can not set schedule. For schedule, please set [WatchState Settings] Dialog 
Box mentioned above. 

 
[Properties] Dialog Box of Server 

NEC ESMPRO Manager sends management packet to server and judges that server is stopped if not 
responded. 
Therefore, in case that server is in sleep mode and in case of network problem while server actually 
operates, alert of [No response from the server.｣is reported. 
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2.3 Configuration Information of Server and 
Management Operating Status (DataViewer) 

You can check the configuration information and operating status of server by DataViewer. 
It displays various items such as hardware, software components, voltage, temperature and others in real 
time. 
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2.3-1 How to check configuration information and operating status 

1. Procedures 

1.  Activate Operation Window and select server by left tree of screen. 
2.  Select [DataViewer] from [Tools] menu. 
3.  DataViewer activates and the information gotten from server is displayed. 

 
DataViewer 

 

2. Preparation 

In order to refer to information by DataViewer, it is necessary to register on Operation Window in 
advance. 
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2.4 Check of Long-Term Operating Status of Server 
(Automatic Data Collection) 

 
By utilizing Automatic Data Collection, you can regularly collect the statistical information of server, graph and 
print. Statistical information can make you analyze the operating status of server, maintain the system and 
expansion plan. 
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1. To set automatic data collection 

1.  Select [Automatic Data Collection Setting…] from [Tools] menu of DataViewer. 
2.  On setting Dialog Box, server list is displayed on the right side. Select and add the server you want 

to make automatic collection. Please change collection cycle, if required. 

 
[Automatic Data Collection Setting] Dialog Box 

 
40KB disk space is necessary to collect information per server. 
 

 
It is output at predefined position(~/Program Files/ESMPRO/esmwork/esm) in CSV form. 
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2. How to print out collected data 

1.  Select [Print Statistical Data…] from [Tools] menu of DataViewer. Please set necessary items at 
displayed Check of Long-Term Operating Status of Server (Automatic Data Collection) screen and 
press [Print…] button. 

 
[Print Statistical Data] Dialog Box 

 

3. How to graph collected data 

1.  Select server you want to graph by Operation Window and activate DataViewer. 

2.  Display the screen CPU information by DataViewer, press graph button( ) and activate 

GraphViewer. 
3.  Select [Open statistics…] from [File] menu of GraphViewer. 
4.  As confirmation of deletion of graph and data is displayed, press [Yes]. 
5.  Select [Add graph lines….] from [Edit] menu and add the items to be added. 

 

GraphViewer 
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4. About Collected Statistical Information 

The statistical items to be collected when you execute Automatic Data Collection for NEC ESMPRO 
Agent Ver. 4.3/4.4 are as follows: 
However, the items not to support by server to be monitored are not collected. 

 
Automatic Data Collection collects server information at that time in a set collecting cycle.｡ 
For instance, the data of statistical item "Rate of CPU load 1 min (%)" is not accumulated or calculated 
Rate of CPU load on NEC ESMPRO Manager side but is collected the data of Rate of CPU load 1 min 
(%) calculated on NEC ESMPRO Agent side in advance at the time of collection. 

 
[Statistical Item List] 
CPU Information 
 

CPU load(%)  
Rate of CPU load 1min(%)  
Rate of CPU load 5min(%)  
Rate of CPU load 30min(%)  
Rate of CPU load 1hour(%)  
Rate of CPU load 1day(%)  
Rate of CPU load 1week(%)  
User Mode(%)  
Privileged Mode(%)  
Nice Mode 

Memory Information Correctable Error  
Uncorrectable Error  
Physical Memory Available(KB)  
Physical Memory Currently Used(KB)  
Physical Memory Percent Used(%)  
Page File Available(KB)  
Page File Currently Used(KB)  
Page File Percent Used(%) 

Network Statistical Information Received Total Octets  
Received Total Packets  
Received Unicast Packets  
Received Non-Unicast Packets  
Received Packets Disposed  
Received Error Packets  
Received Undefined Protocols  
Transmitted Total Octets  
Transmitted Total Packets  
Transmitted Unicast Packets  
Transmitted Non-Unicast Packets  
Transmitted Packets Disposed  
Transmitted Error Packets  
Transmitted Queue Length 

Network MAC Information Received Alignment Errors  
Received FCS Errors  
Received Excessive Frames  
Received Additional Errors  
Transmitted Carrier Sense Errors  
Transmitted Late Collisions  
Transmitted Excess Collisions  
Transmitted Multiple-Collision Frames  
Transmitted Single-Collision Frames  
Transmitted Delayed Frames  
Transmitted Additional Errors 

OS Information Number of processes  
Number of threads 

Temperature Information Temperature 
Voltage Information Voltage Level(mV) 
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Fan Information Fan Speed 
File System Information Unused Capacity(MB)  

Used Clusters  
Hard Disk Information Device Read Sectors  

Device Write Sectors  
 
As for ft server, the following information is also collected in addition to the above. 
CPU Module Information CPU Module Correctable Error  

CPU Module Intermittent Error  
CPU Module Uncorrectable Error 

Memory Information Correctable Error  
Uncorrectable Error  
Intermittent Error 

Ethernet Board Information Received Good Frames  
Received Total Collisions  
Received Total Errors  
Received CRC Errors  
Received Alignment Errors  
Received Resource Errors  
Received Overrun Errors  
Received Short Frame Errors  
Transmitted Good Frames  
Transmitted Total Collisions  
Transmitted Total Errors  
Transmitted Max Collisions  
Transmitted Late Collisions  
Transmitted Under Runs  
Transmitted Lost CRS 
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2.5 Quick Detection of Server Failure (AlertViewer) 
Report (Alert) of server failure is promptly sent to NEC ESMPRO Manager. 
If you activate AlertViewer, when you receive Alert, Pop-up is displayed. Therefore, you can recognize it 
immediately. 
As alert includes detailed information of failure and countermeasure to it, you can handle the alert properly. 
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2.5-1 To check alert 

1. Procedures 

1.  Activate [NEC ESMPRO Manager] from NEC ESMPRO Manager program group. 
AlertViewer activates in minimization (iconization) position. 

 
You can also activate AlertViewer by selecting [AlertViewer…] from [Tools] menu of Operation 
Window. 

 
2.  When alert happens, Pop-up Dialog Box is displayed. Press [Alert Log] here, detailed screen is 

displayed. You can check the detailed information of failure and handling method. and others. 

 [Alert] Pop-up Dialog Box 

Details Screen of Alert 

When you do not activate AlertViewer, Pop-up is not displayed. However, alert is received. When you 
activate AlertViewer later, received alert is displayed on alert list. 
 
Around 1KB disk space is necessary for one alert. 
 
 
The alert which happened when the power of NEC ESMPRO Manager machine was off can be received 
after power-on of NEC ESMPRO Manager machine by designating retransmission setting through 
TCP/IP report on NEC ESMPRO Agent side. 
For details, refer to P. 2.5-3 “How to utilize various report method”. 
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2. Preparation 

To receive alert regarding server failure at NEC ESMPRO Manager, setting address of machine installed 
NEC ESMPRO Manager for Trap Destination on server side is required. 
Please set Trap Destination in the following manner. 
 
1.  Select [Administrative Tools] - [Services] of Control Panel. 
2.  Select ”SNMP Service” on [Services] screen and select [Action]-[Properties] from menu. 

 
Property of SNMP Service 

3.  Select [Traps] tab and add the address of the computer on which NEC ESMPRO Manager is 
installed to the Trap destinations list. Click [OK]. 

 
In addition to the alert by SNMP Trap, the alert of high reliable alert of NEC ESMPRO Agent can be 
used. 
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2.5-2 How to report (Alert) necessary failure only 

By setting threshold for various monitoring item regarding server such as Rate of CPU load and free space of 
file system by DataViewer, for instance, in case CPU load anomaly happens in server, alert is immediately 
reported to NEC ESMPRO Manager. 
Alert has three kinds of level, ”Information”, ”Minor“ and ”Major”. Yon can take precautions to prevent major 
failure, by alert of status in a phased manner. 
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1. How to set threshold 

For example, you can set threshold of CPU in a following manner: 
 
1.  Activate DataViewer by Operation Window 

Trace in [System]-[CPU] order on the left tree of DataViewer and select the tree below it and 
display the detailed CPU information to set threshold on the right of DataViewer. 
 

 
CPU ([1]CPU) of DataViewer 

2.  When you press threshold button ( ) which is on left of Threshold item, Set Threshold screen 

opens. 

 

[Set Threshold] Dialog Box of CPU 

3.  For monitoring, check [Enable Threshold]. 
4.  When you check [Enable Threshold], the Rate of CPU load of server is checked based on the value 

set here whether it is normal or not. Every time the status of server changes, alert is reported. (ex. 
Normal -> Warning and Warning -> Normal). 
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2.5-3 How to utilize various report method 

1. Alert method to Manager 

Alert method to Manager has the following three kinds: 
- Manager(SNMP) 
- Manager(TCP/IP In-Band) 
- Manager(TCP/IP Out-of-Band) 

 
Manager(SNMP) is reported by SNMP Trap of SNMP service. 
Besides NEC ESMPRO Manager, alert can be executed for “Manager supporting SNMP”. 
Manager (TCP/IP In-Band) uses TCP/IP and communicates with Manager, thus high reliable alert can 
be executed.. 
Manager (TCP/IP Out-of-Band) communicates with remote Manager by using TCP/IP as same as 
In-Band but its alert is executed through Remote Access Service. 
In case that NEC ESMPRO Agent and Manager exist at remote location, the alert can be executed to 
Manager via public line by utilizing Manager(TCP/IP Out-Of-Band). 
 

Manager(SNMP) is simple protocol using UDP protocol. Therefore, alert may delay and be lost. In this 
case, NEC recommends high reliable Manager (TCP/IP In-Band). In case of using Manager (TCP/IP 
Out-Of-Band), NEC ESMPRO Agent and Manager needs mode respectively. 

 
In case that NEC ESMPRO Agent and Manager exist on the same LAN, because you can freely set retry 
term and retry interval by using Manager (TCP/IP In-Band), even in the environment where the 
machine of Manager is not power-on, alert can be surely executed. 

 

2. Other alert methods 

At the time of server failure, besides alert to Manager, the following alert methods can be used from 
NEC ESMPRO Agent. 
 
Pager Alert 
Paging by pager 

* It not supports since Ver4.0.  
 

For using pager, modem is required for each server. 
 

 
By using pager, you can report alert in real time to maintenance personnel at remote location and do 
alert urgent failure to system administrator. 

 
Even though line is busy, alert is successfully executed. 
 

 
Report to Client 
By utilizing Messenger Service, you can report client within the same domain. 
 

Alert can be executed for server other than administrator (Administration Terminal). 
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3. Preparation 

In order to set reporting alert, you can do Alert Manager Setting Tool. 
 
1.  Activate Alert Manager Setting Tool. 
2.  Basic setting of alert 

Select [Base Setting] from Setting menu of menu bar or click [Base Setting] of toolbar. [Base 
Setting] Dialog Box is displayed. Here, alert method which is common to basic setting (Selection of 
serial port of pager and etc.) is set. 

 
[Base Setting] Dialog Box 

The necessity of Alert Basic Setting depends on alert method At the time of selecting alert 
method, the items you can press [Configure] button are alert method necessary for Alert 
Basic Setting. 
 

3.  How to make out destination of alert 
Select [Destination Setting] from [Setting] menu of menu bar or click [Destination Setting] of 
toolbar. [Destination Setting] Dialog Box is displayed. 
Here, by using optional alert method, you set optional destination of alert. 

 
 [Destination Setting] Dialog Box 
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You can report alert to multiple destinations by one alert method. In addition, you can group the 
multiple destinations of alert and thus easily manage the destination of alert. 
 
 

4.  Link monitor Event to alert. 
In case an event for monitoring happens, alert is reported to the destination of alert linked here. 
Select Event for monitoring from EventLog of tree view and Event of NEC ESMPRO Agent by 
mouse and click right mouse button. Select [Link Destination] from displayed Pop-up menu. After 
[Link Destination] Dialog Box is displayed, select link of alert, link destination of alert to Event. 

 

 
[Link Destination] Dialog Box 

By linking Event to optional destination of alert you want to make alert at the time of server failure, you 
can set destination of alert, depending on the operating environment. 

 
       If you delete destination of alert and group, they are deleted from Event for  

monitoring and alert. 
      Please be careful when you delete destination of alert and group. 
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2.6 Addition of Monitoring Items of Server  
(Local Polling) 

By using Local Polling function, setting threshold, threshold monitoring, and alert report can be made for even 
items which do not have threshold setting button. 

 

 
Local Polling 
Local Polling means function to monitor optional items (integer only) which is not supported by GUI of 
DataViewer. As it monitors by NEC ESMPRO Agent (local) locally based on set information, it is called 
Local Polling. You can set it meeting system environment to reflect server status color and generate 
alert. 
However, setting is required for special knowledge and MIB information of monitoring items. 
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1. How to use Local Polling function 

1.  Activate DataViewer. 
2.  Select [Local Polling] of tree. 

 
[Local Polling] of DataViewer 

3.  When you select item field of right pane, [Configure…] button becomes available. Click it. 
4.  Input object ID of MIB in [Item] of [Local Polling Settings] Dialog Box. By clicking [Browse…] 

button, you can also select it from MIB List set in advance. 
5.  Set [Duration], [Interval] [Maximum Value] and [Minimum Value]. 
6.  Set threshold. 

 

[Local Polling Settings] Dialog Box 

For Local Polling, value of Upper and Lower respectively for monitoring item can be set. For 
instance, as temperature needs right range of value, you need to set values for Upper and Lower. 
Meanwhile, for CPU load and others, you need to set Upper value only because it can be regarded 
as malfunction when it exceeds optional rate of load. 
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* When the monitored item value exceeds (falls below) Upper (Lower) value, it is determined as 
malfunction or warning and status changes. Upper (Lower) Reset recovers the judgment of 
malfunction and warning in case of exceeding (falling below) this value. 

 
7.  By changing the setting of [Enable Polling], you can set whether or not execute polling to MIB. 

Only in case of check here, the value you set on [Interval] can be valid. 
 

In case SNMP related product (SNMPAgent) is installed in server, you can monitor MIB which is defined 
by its product in the same manner mentioned above. 
However, for designating object ID in [Setting of Local Polling] Dialog Box, special knowledge is 
required because you need to investigate in advance how MIB is defined on the product. 
 
Ex:  Monitoring database engine which has SNMPAgent function by NEC ESMPRO Manager. 
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2.7 Remote Start-up of Server (Remote Wake Up) 
You can start up the system which stops on network. 

 
How to start-up server from remote site 

 
Relevant server is required to meet Remote Wake Up function. 
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1. How to start-up remote wake up function 

1.  Click relevant server icon on Operation Window. 
2.  Select [Remote Wake Up Tool] with right mouse button. 
3.  When you press [OK] button, Magic Packet frame is sent and power of server is activated. 
4.  You can confirm start-up of machine by changing status color of relevant server icon on Operation 

Window to other than unknown (gray). 

 

Remote Wake Up Tool 

You can start up plural servers at once 
Select relevant server icon multiply on Operation Window, or select relevant host name in [Remote 
Wake Up] Dialog Box. 

 

2. Preparation 

1.  Select relevant server icon on Operation Window and select [Properties] with right mouse button. 
2.  Select [Function] tab and input [RWU MAC Address] and [RWU IP Broadcast Address]. 

 
[Properties] Dialog Box of Server 

3.  Click [OK] and close [Properties]. 
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Setting of Remote Wake Up on server side is required. For details, refer to instructions of machine to be 
activated. 
When you want to start it up over router, setting of direct broadcast is required for router. For details, 
refer to the instructions of router. 

 
RWU MAC Address 
Set MAC address for Remote Wake Up function set for the machine to be activated. For details, refer to 
the instructions of the machine to be activated. 
 
RWU IP Broadcast Address 
Used to send Magic Packet frame to the machine to be activated. Confirm with network administrator 
about IP broadcast address. 

 
Magic Packet Frame 
Means particular packet to start up stopped system from remote site. 
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2.8 Remote Shutdown of Server (Remote Shutdown) 
You can shut down the system operating on network from remote site. 
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1. To shut down server from remote operation 

1.  Select map including the server to shut down on Operation Window 
Drag mouse by right pane on Operation Window and select the relevant server. 

 
Selection of Server for Remote Shutdown 

 

2.  Select the relevant server and [Remote Shutdown] from [Tools] menu. 
 

 
Remote Shutdown Menu 
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3.  Select list from server you want to shut down on [Remote Shutdown] Dialog Box and select 
[Action] you want by radio button. 

 

 

[Remote Shutdown] Dialog Box 
4.  When you press [Execute] button, shutdown of computer is executed. 
5.  You can confirm the shutdown of computer by the execution result. 
 
 

In case of some server models, power-off might not take place after shutdown. 
 

 
When you select Remote Shutdown with selecting map on Operation Window, all the servers under 
map are displayed on Remote Shutdown Dialog Box. 

 
You can also shut down it by opening [Remote Shutdown] from [Tools] of menu, after activating 
DataViewer of relevant server. 
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2. Preparation of Server 

In order to execute Remote Shutdown, setting of NEC ESMPRO Agent of relevant server is required. 
 
1.  Select NEC ESMPRO Agent of control panel. 
2.  Check Permit Remote Shutdown / Reboot｣in the setting field of SNMP of [General] tab. 

 

Control Panel of NEC ESMPRO Agent [General] 

3.  Press [Report Setting…] button of [General] tab and Open screen of Alert Manager. 
4.  Select [Base Setting…] from [Setting] menu and open Base Setting screen Confirm that 

“Shutdown Delay” item is green icon like below. If it is red, click the icon and change to green. 

 
[Base Setting] Dialog Box 

5.  Press [OK] button and close screen. 
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2.9 Easy Management of Large-Scale Network 
(Inter-Manager Communication) 

NEC ESMPRO Manager supports Inter-Manager Communication which enables management of larger-scale 
network by exchanging information each other with multiple NEC ESMPRO Managers. 
When you utilize this function, for instance, 
 

1.  The servers of each branch manage are managed by Manager to be installed at each branch. 
2.  You can confirm the status of server using Inter-Manager Communication by connecting the 

Manager of each branch from the Manager of headquarters. 
  
Hierarchical management can be done like above. 
You can refer to the information of server of branch, by activating DataViewer from the server of 
headquarters. 
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1. How to use Inter-Manager Communication 

1.  Check ”Manager Name”, ”IP Address” and ”Password” of Manager to which you want to connect. 
In case that the Manager to which you want to connect is not yet set, please set the Manager 
according to the following procedure. 

 
In case of connection through a router and others, please set routing information and others of the 
router beforehand. 

 
2.  Select [Customize]-[My Manager] form [Options] menu of Operation Window. [My Manager] 

Dialog Box is displayed. 

 

[My Manager] Dialog Box 

3.  Check [Manager Name] and [Port Number] on [My Manager] Dialog Box. 
 

[Manager Name] must not be set the same name as all the other remote Manager(s). Change name 
not to duplicate. [Port Number] is not required to change. Change it only if duplication of the port 
number for other application happens. You must reboot the system after changing the port number. 

4.  Select [Customize]-[Remote Manager] from [Options] menu of Operation Window and display 
[Remote Manager] Dialog Box. 

5.  Click [Add…] button and display [Neighbor Manager] Dialog Box. 

  

[Neighbor Manager] Dialog Box 

6.  Designate other Manager Name for [Manager Name]. 
7.  Set IP address of other machine for [Address]. 
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8.  Input the same password as you input [Neighbor Manager] Dialog Box of other side for 
[Password]. In order to avoid misinputting password, input the same password in [Confirm 
Password] once again. Do not use space, tab character, double quotation ("), single quotation ('), 
backslash (\) for password. 

9.  Press [OK] button after finishing input and close [Neighbor Manager] Dialog Box. 
10.  The display field of [Neighbor Manager] tab displays entry of Neighbor Manager which you newly 

added in “disconnected” position. If the registered contents have no problem, click [OK] button. 
11.  When you activate Operation Window and you can refer to the information of other Manager as 

below. 

 
Operation Window 

Please be careful of billing and others because packet is sent to network at interval designated by 
[Reconnect Time] of [Neighbor Manager] Dialog Box while you connect to other Manager using 
Inter-Manager Communication and even if you do not refer to other Manager screen. 

 
How to redirect alert report 
1. On the side of Manager which redirects alert, open [Customize]-[Remote Manager] Dialog Box 

from [Options] menu of menu bar of Operation Window, select [Notification Event] tab and 
press [Add…] button. 
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[Notification Event] Dialog Box 

2. Set the Manager name of alert to be redirected, and check the checkbox of [Notification 
SNMP-trap]. 

3. To report alert in case of alert failure, check [[Enable] of [Alert Retry] and set [Retry count] and 
[Retry cycle]. 

4. Press [OK] button and close Dialog Box 
5. Activate Operation Window. 

After reboot, with connection by Inter-Manager Communication, the alert the redirected 
Manager received is to Manager set by Manager Name] of [Notification Event] Dialog Box 

 
 

 

 58



2.10 Identify Function  
You can identify chassis by lighting of ID LED when using Identify Function. 
 
 

1. How to use identify function 

1.  Click relevant server icon on Operation Window. 
2.  Select [Identify] depending on version by right mouse button. 

 

Identify Menu 

3.  [Identify] Dialog Box is displayed. 

 

[Identify] Dialog Box 

4.  When you press [Start] button, Identify is displayed. 
5.  When you press [Stop] button, Identify stops. 
 

The target must be NEC ESMPRO Agent Ver. 4.0 or later installed, and Identify must be supported. 
 
 

 In case started Identify on NEC ESMPRO Agent itself, NEC ESMPRO Manager can not stop Identify. 
In addition, in case you started Identify by NEC ESMPRO Manager, NEC ESMPRO Agent itself can not 
stop identifying chassis. 
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2.11 Suppression of Blade Chassis Sensor Report 
This chapter describes how to set alert of Event concerning chassis sensor of Blade server. 
In blade server, in case chassis sensor detects failure, alert is made redundantly from all the Blade servers 
among the same blade storage unit.  You can avoid these alerts by setting alert. 
 

As for SIGMABLADE, this function is not related because redundant alerts are not reported. 
 

1. How to suppress blade chassis sensor report 

1.  Click relevant blade map or blade server icon on Operation Window. 
2.  Select [Blade Chassis Sensor Report Setting] by right button of mouse. 

 
Blade Chassis Sensor Report Setting Menu 

3.  Select only server to alert from list of [Blade Chassis Sensor Report Setting] Dialog Box. 

 

[Blade Chassis Sensor Report Setting] Dialog Box 

4.  When pressing [Execute] button, Blade Chassis Sensor Report Setting is executed. 
5.  After execution, confirm the execution result of list. 
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 In order to operate from NEC ESMPRO Manager, the following is require to be set on NEC 
ESMPRO Agent side. 
- To be permitted setting on SNMP from Manager by control panel of NEC ESMPRO Agent 
on NEC ESMPRO Agent side 

- In setting of SNMP service on NEC ESMPRO Agent side, the right of community name set 
on NEC ESMPRO Manager is "READ_WRITE" or "READ_CREATE". 
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2.12 Redirect SNMP Trap to Other Vendor’s Console  
(SNMP Trap Redirection) 

There are many different types of alert from NEC ESMPRO Agent. In order for the console of other vendor's 
product to directly receive and display it, the message definition file of alert meeting each type is necessary.. 
By utilizing Trap Redirect Function, you can reduce your work drastically to display the console managed by 
other vendor because you can receive the alert of NEC ESMPRO Agent received by NEC ESMPRO Manager 
which is converted into single format. 
 

You must not Redirect Trap to NEC ESMPRO Manager and display it. 
 

For details of Trap Redirect Function, refer to ”SNMP Trap Redirection Help”. 
For ”SNMP Trap Redirection Help”, select [Program]-[NEC ESMPRO Manager]-[ SNMP Trap Redirection 
Help] from [Start] button of taskbar. 

2.12-1 How to redirect trap 

1. How to set destination of redirection 

1.  Select [Program] from [Start] button of taskbar and [SNMP Trap Redirection Setting] of program 
group of [NEC ESMPRO Manager]. 

 

SNMP Trap Redirection Setting Screen 

2.  Press [Add…] button on [SNMP Trap Redirection Setting] Dialog Box and open  Destination 
Setting Screen. 

 
Destination Setting Screen 
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3.  Input Host name or IP address for destination to be redirected of SNMP Trap in [Host name or IP 
address] and input Community name to use when you redirect SNMP Trap in [Community name] 

4.  Press [Set] button. At this time, in case a message which indicates that service is not started is 
displayed, please start the service according to the following procedure. 

5.  Press [Close] button. 
 
 

2. How to start ESMPRO/SM Trap Redirection Service 

After installation of NEC ESMPRO Manager, ESMPRO/SM Trap Redirection service stops by default. Therefore, 
you need to start ESMPRO/SM Trap Redirection service 
 

1.  Select [Control Panel] - [Administrative Tools] - [Services] from [Start] menu of taskbar. 
2.  Select "ESMPRO/SM Trap Redirection" on [Services] screen and select [Action]-[Properties] from 

menu. 

 

Services Screen 
 

3.  Change the followings with [General] tab on Property Screen of ESMPRO/SM Trap Redirection and 
click [OK] button. 

 
Startup type: Manual ->Automatic 
Service status: Stopped -> Started 
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[General] Tab Screen of ESMPRO/SM Trap Redirection Property 

 
 

3. Trap formation to be redirected 

The followings are the specification of trap to be reported by Trap Redirection. 
For details, refer to the MIB definition file (ESMMNGR.MIB, ESMTPGEN.MIB) to be installed under the folder 
of \ESMPRO\ESMMNG\mib to which NEC ESMPRO Manager is installed. 
SNMP version is SNMPv1. 
 
ESMMNGR.MIB Describes the definition of managerTrap. 
ESMTPGEN.MIB Is the source of import of Trap object to be used in managerTrap.  

Though there is Trap definition in this file sending is not made in this function. 
 

Field  Value  
Enterprise managerTrap 

(1.3.6.1.4.1.119.2.2.4.4.100.2) 
 

Agent address IP Address of server sent the trap  
Generic trap 
type 

Enterprise Specific(6) Generic trap code 
6:Enterprise specific traps 

Specific trap 
type  

managerTrapInformation(1) 
managerTrapWarning(2) 
managerTrapFatal(3) 

Specific trap code 
1:Information traps 
2:Warning traps 
3:Fatal traps 

Timestamp “0”Fixed  
managerName Manager name of server to send trap 
managerHostName Sever name sent trap 

In case of no-registration on Operation 
Window,“unknown”is applied. 

Variable 
Bindings 

managerIPAddress IP address of server sent trap 
trapGenName Outline of trap 
trapGenDetailInfo Detailed information of trap 
trapGenAction Countermeasure of Trap 
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Field  Value  
trapGenClassification Product name of Trap 
trapGenSourceName Trap Service 
trapGenEventID Event ID of trap 

In case data do not exist, ffffffff(-1) is applied. 
trapGenAlertType Alert type of Trap 
trapGenEventTimeStampWithOffset
FromUTC 

Time of Trap occurrence 
Format : YYYYMMDDHHMMSS.UUUUUU±OOO 
YYYYMMDD … Year, Month, Day 
HHMMSS … Hour, Min., Sec. 
UUUUUU … Microsecond 
±OOO … Offset from agreed 

world time(Min.)  
 
 

2.12-2. How to set console managed by other vendor 

You need setting in accordance with product, in order to display the redirected Trap on management console 
of other vendor. 
For details, refer to manual of each management console or ask for the manufacturer. 
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2.13 Server Management by Script  
(Script Component) 

By using Script Component, you can manage server by utilizing VBScript, Script and others. 
By using Script Component, the following is possible: 
 

- To obtain Map and Server List of Operation Window 
- To obtain configuration information of server 
- To register alert to AlertViewer 
- To activate server remotely 
- To shut down server remotely 

 
For details of Script Component, refer to ”Script Component Help”. For ”Script Component Help”, 
press[Program]-[NEC ESMPRO Manager]-[ Script Component Help] form [Start] button of taskbar. 

 
 

1. How to use Script Component 

By installing NEC ESMPRO Manager, Script Component is installed automatically. 
 

Execution Case Using Sample (Tree View of Map and Server) 
 

1.  Execute AutoDiscover on Operation Window. 
2.  Open sample " TreeView.vbs " which is \esmpro\esmmng\scripts installed NEC ESMPRO 

Manager by Notepad. 
3.  Change " MAP_NAME " to "top" in sample and store it in optional location. 
4.  Activate Command Prompt and execute file stored above 3. 

> cscript TreeView.vbs 
5.  Tree configuration registered on Operation Window is displayed. 

 
Operation Window 
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Command Prompt (Script Component Execution Result) 

You can set server down monitoring for all the servers and execute various tasks such as changing SNMP 
community name. 
Other samples using Script Component other than the sample mentioned above are prepared 
For details, refer to Help of Script Component. 

 
Windows Script Host Version 5.6 or later is required to use Script Component. 
 

 
It is necessary to access Script Component by member of Administrators Group or NEC ESMPRO User 
Group. 
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2.14 Extension of Report method 

2.14-1 Alert Method to Manager 

Alert method to Manager has the following three kinds: 
- Manager(SNMP) 
- Manager(TCP/IP In-Band) 
- Manager(TCP/IP Out-of-Band) 

 
Manager (SNMP) is reported by SNMP Trap of SNMP service. 
Besides NEC ESMPRO Manager alert can be executed for “Manager supporting SNMP”. 
Manager (TCP/IP In-Band) uses TCP/IP and communicates with Manager, thus high reliable alert can 
be executed. 
Manager (TCP/IP Out-of-Band) communicates with remote Manager by using TCP/IP as same as 
In-Band but its alert is executed through Remote Access Service. 
In case that NEC ESMPRO Agent and Manager exist at remote location, the alert can be executed to 
Manager via public line by utilizing Manager (TCP/IP Out-Of-Band). 

 
Manager (SNMP) is simple protocol using UDP protocol, Therefore alert may delay and be lost. In this 
case, NEC recommends high reliable Manager (TCP/IP In-Band).  In case of using Manager (TCP/IP 
Out-Of-Band), NEC ESMPRO Agent and Manager needs mode respectively. 

 
In case that NEC ESMPRO Agent and Manager exist on the same LAN, because you can freely set retry 
term and retry interval by using Manager(TCP/IP In-Band), even in the environment where the machine 
of Manager is not always power-on, alert can be surely executed. 

 

2.14-2 Other alert methods 

In case of server failure, in addition to alert to Manager, the following alert methods can be used from 
NEC ESMPRO Agent. 
 
Internet Mail 

Reports alert to Mail server supporting SMTP by Internet Mail. 
Mail server can be used for both LAN and WAN. 
 

Mail 
Executes mail alert by using MAPI. 
MS Mail or Exchange Clients or Outlook is required to be installed. 
In case the above MAPI support product can not be set up, Mail can not be set. 
 

Mail does not support the versions following Exchange2000 client and Outlook2000. 
 
 

Pager 
can page pager from Manager. 
* It not supports since Ver4.0. 

 
Pop-up Message 

displays Pop-up Message on screen. 
Only one Pop-up Message is always displayed on screen. In case there are many Messages, if you 
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press button, it is displayed in series. 
 

Print 
Prints out at the occurrence of alert, it can be printed out to  network printer. 
 

Report to Client 
Report alert to client among the same domain at the same time by using Messenger service. 

 
Run Command 

Executes command you designated at the occurrence of alert. 
Can submit the information such as whether failure happens in computer, failure  
time, failure contents, as command argument. 
 

Write File 
Writes in text file at the occurrence of alert. 

 Internet Mail 
 Mail 
 Pager 
 Pop-up Message 
 Print 
 Report to Client 
 Run Command 
 Write File 

 

2.14-3 Preparation 

You can set reporting alert by Alert Manager setting tool. 
 
1.  Activate Alert Manager. 
2.  Basic setting alert method 

Select [Base Setting] from [Setting] menu of menu bar or click [Base Setting] tool bar. [Base 
Setting] Dialog Box is displayed. 

[Base Setting] Dialog Box 

Base Setting is required only for Internet Mail and Pager. Base Setting is not required for 
other alert methods. 
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Internet Mail 

[Internet Mail Base Setting] Dialog Box 

 
Mail Server(SMTP) Designates host name or IP address of mail server supporting 

SMTP.  
E-mail Address Sets mail address to be sender (From). 
SMTP Port number Designates port number of SMTP. 
Send Date: field Designates whether you add send field to mail header 

information. 
 

Pager 

 

[Pager Setting] Dialog Box 

Serial Port Designates serial port to use. 
Modem Initialization 
String1 

Designates initialization command of modem. In case modem 
properly operates, change is not required. 

Modem Initialization 
String 2 

In case initialization command can not be sent at the first time, 
designating an additional initialization command is required.  In 
case modem properly operates, change is not required. 

 
 
3.  Make up alert destination 

Select [Destination Setting] from [Setting] menu of menu bar or click [Destination Setting] of 
toolbar. [Destination Setting] Dialog Box is displayed. 
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[Destination Setting] Dialog Box 

Alert Destination (ID) relating to each alert method is prepared one by one in advance. Select the 
ID of alert method you use and click [Address] button from screen which is displayed after clicking 
[Modify ID] button. 
 
You can report alert to multiple destinations by one alert method. In addition, you can easily 
manage Alert Destination because the multiple destinations can be grouped. 
 
Setting for Alert Destination You use 
 
Internet Mail 

 
[Internet Mail Setting] Dialog Box 

To Designates mail destination address. You can designate multiple 
addresses in case of no more than 80 bytes in total. In that case, 
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separate each address with ”,”. 
Subject Designates Subject. 
Message Head The contents you designated are inserted to header of message 

body. 
Use Remote Access Service 
Enable In case there is check here, ESMPRO connects to Internet Mail by 

Dial-up at the time of alert and cuts off after alert. 
 

 
 
Mail 

 [Mail Setting] Dialog Box 

Subject Designates Subject. 
Message Head The contents you designated are inserted to header of message 

body.  
Select To and Cc from address book. Designate file if required. 
 
Pop-up Message 

 [Pop-up Message Setting] Dialog Box 

Title designated here is displayed on title bar of The character you 
Pop-up Message. 

Pop-up Message displays the item ticked on the checkbox. 
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Printer Output 

[Print Setting] Dialog Box 

ame Printer N Designates printer to be used 
Header The contents are inserted to header of print body. 
Footer The contents is inserted to footer of print body 

The item ticked on checkbox is output. 

Write File 
 

[Write File Setting] Dialog Box 

File Name ame of output destination. Designates file n
Header The contents you designated are inserted to header of output 
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message body. 
The item ticked on checkbox is output. 
 
Command Execution 

[Run Command Setting] Dialog Box 

Command Line Designates command to execute. 
Display Window Designates whether you display run command on window. 

In case there is check, window is displayed. 
Retrieve the termination 

 
When you get return value of command, tick the checkbox. 

status
 

 
5. 

and click right mouse button. Select [Link Destination] from Pop-up Menu to be displayed. 
[Link Destination] Dialog Box is displayed, select Alert Destination and connect Alert Destination to 
Event. 

 

 

 How to connect Alert Destination to Monitoring Event. 
In case Event to be monitored happens, alert is reported to Alert Destination you connected here. 
Select Event to be monitored from Event Log of tree view and Event of NEC ESMPRO Agent with 
mouse 
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[Link Destination] Dialog Box 

 
By connecting Event to report alert to optional alert when server failure happens, you can set Alert 

 
       When you delete Alert Destination and group, they are deleted from Monitor  

 
     Please be careful when you delete Alert Destination and group. 

 

Destination according to operating environment. 

   
Event and alert report. 


